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1. Related Manuals
To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for each device that is used in the
system.
The following shows the manuals for OMRON Corporation (hereafter referred to as OMRON)
and Delta Tau Data Systems, Inc (DT).
Manufacturer

Manual No.

OMRON

I610-E1

Model
Model CK3E-

Manual name
Programmable Multi-Axis Controller
Hardware User’s Manual

OMRON

W580-E1

Model NY51-A

Industrial PC Platform NY-series IPC
Programmable Multi-Axis Controller
Hardware User’s Manual

OMRON

I576-E1

Model R88M-K

R88M-K, R88D-KN-ECT AC

Model

Servomotors/Servo Drives (Built-in

R88D-KN-ECT

EtherCAT® Communications)
User’s Manual

DT

O014-E

-

Power PMAC User’s Manual

DT

O015-E

-

Power PMAC Software Reference
Manual

DT
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O016-E

-

Power PMAC IDE Users Manual

2. Terms and Definitions
Term
Slave

Explanation and Definition
Slaves are devices connected to EtherCAT. There are various types of
slaves such as servo drivers handling position data and I/O terminals
handling the bit signals.

Object

Represents information such as in-slave data and parameters.

PDO

One type of EtherCAT communications in which Process Data Objects

communications

(PDOs) are used to exchange information cyclically and in real time.

(Communications

This is also called “process data communications”.

using Process Data
Objects)
PDO Mapping

The association of objects used for PDO communications.

PDO Entry

PDO entries are the pointers to individual objects used for PDO
mapping.

ESI file

An ESI file contains information unique to the EtherCAT slaves in XML

(EtherCAT Slave

format.

Information file)

You can load ESI files into the EC-Engineer, to easily allocate slave
process data and make other settings.

ENI file

An ENI file contains the network configuration information related to

(EtherCAT Network

EtherCAT slaves.

Information file)
Power PMAC IDE

This computer software is used to configure the Controller, create user
programs, and monitor the programs.
PMAC is an acronym for Programmable Multi-Axis Controller.

Acontis

This computer software is used to configure the EtherCAT network and

EC-Engineer

each slave.
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3. Precautions
(1) Understand the specifications of devices that are used in the system. Allow some margin
for ratings and performance. Provide safety measures, such as for installing a safety
circuit, in order to ensure safety and minimize the risk of abnormal occurrences.
(2) To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for each device that is used in
the system.
(3) The user is encouraged to confirm the standards and regulations that the system must
conform to.
(4) It is prohibited to copy, reproduce, or distribute a part or the whole of this document
without the permission of OMRON Corporation.
(5) The information contained in this document is current as of July 2016.
It is subject to change without prior notice for improvement purposes.
The following notations are used in this document.
Indicates a potentially hazardous situation which, if not avoided,
may result in minor or moderate injury, or may result in serious
injury or death. Additionally, there may be severe property
damage.
Indicates a potentially hazardous situation which, if not avoided,
may result in minor or moderate injury, or property damage.

Precautions for Correct Use
Precautions on what to do and what not to do to ensure correct operation and performance.

Additional Information
Additional information to read as required.
This information is provided to increase understanding or make operations easier.
Symbols
The filled circle symbol indicates operations that you must carry out.
The specific operation is shown in the circle and explained in text.
This example indicates a “general precaution” for something that you must
carry out.
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4. Overview
This document describes the procedures used to operate the OMRON servo drivers
(G5-series EtherCAT communication built-in type, hereafter referred to as Servo Driver) using
the motion program for OMROM Programmable Multi-Axis Controller (hereafter referred to as
the Controller), model CK3E-/NY51-A, as well as for checking the operation.
In the document, Servo Driver and servomotors to be connected are collectively called motion
control devices. Servo Driver may also be referred to as a slave depending on the
explanation.
Refer to Section 6. EtherCAT Connection Procedure to learn about the setting methods and
key points to perform PDO communications via EtherCAT. In this document, the motion
program is used to check operations.

The range of usage of this document is checking the connection of motion
control devices connected via EtherCAT. When using instructions and
constructing systems that are not described in this document, always read and
follow the information provided in all Safety Precautions and Precautions for
Safe Use in the manuals for each device that is used in the system.
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5. Applicable Devices and Device Configuration
5.1. Applicable Devices
The applicable devices are as follows:
Manufacturer

Name

OMRON

Programmable Multi-Axis Controller

Model
Model CK3E-

OMRON

Programmable Multi-Axis Controller

Model NY51-A

Industrial Box PC
OMRON

Servo Driver

Model R88D-KN-ECT
Model R88D-KN-ECT-L

Precautions for Correct Use
In this document, the devices with models and versions listed in Section 5.2 are used as
examples of applicable devices to describe the procedures to connect the devices and check
their connections.
You cannot use devices with versions lower than the versions listed in Section 5.2.
To use the devices mentioned above with models not listed in Section 5.2 or versions higher
than those listed in Section 5.2, check the differences in the specifications by referring to the
manuals before operating the devices.

Additional Information
This document describes the procedures to establish the network connections. It does not
provide information on operations, installations, wiring methods, device functionalities, or
device operations, which are not related to the connection procedures. For more information,
refer to the manuals or contact your OMRON representative.
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5.2. Device Configuration
The hardware components to reproduce the connection procedures in this document are as
follows:

Windows computer
Power PMAC IDE
Acontis EC-Engineer

Model CK3E-

Ethernet
communications

Manufacturer
OMRON
OMRON

OMRON
DT
Acontis

Name
Programmable Multi-Axis
Controller
Servo Driver (G5-series
with Built-in EtherCAT
Communications)
Ethernet cable (with
industrial Ethernet
connector)
Windows computer
Power PMAC IDE setup tool
EtherCAT master setup tool

Model R88D-KN-ECT
Model R88D-KN-ECT-L

EtherCAT
communications

Model
Model CK3E-

Model R88D-KN01L-ECT

Version
Ver.2.2
Ver.2.1

Model
XS5W-T421-M-K
Power PMAC IDE
Acontis EC-Engineer

Ver.2.2
Ver.2.4.3

Precautions for Correct Use
Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

Precautions for Correct Use
Do not share the connection line of EtherCAT communications with other Ethernet networks.
Do not use devices for Ethernet such as a switching hub.
Use the Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or
higher, and use the shielded connector of Category 5 or higher.
Connect the cable shield to the connector hood at both ends of the cable.

Additional Information
This document describes model CK3E- as an example. The same procedures can
apply to model NY51-A.
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6. EtherCAT Connection Procedure
This section describes the procedures to connect the Controller and Servo Driver via
EtherCAT, and to operate the motion control devices. The description assumes that the
Controller is set to factory default.

If an uninitialized Controller is used, the motion control devices may perform
unexpected operations upon power-on depending on the Controller status,
resulting in a personal injury to the user.
To prevent unexpected operations of motion control devices, be sure to initialize
the Controller before connecting the motion control devices and the Controller
via Ethernet cable.

6.1. Workflow
Take the following steps to operate the motion control devices after connecting the Controller
and Servo Driver via EtherCAT.
6.2 Preparation for the Controller Setup

Prepare the Controller settings.

▼
6.2.1 Creation of a New Project
▼
6.2.2 Initial Settings of the Controller
▽
Install the ESI file for Servo Driver

6.3 Installation of ESI Files
▽
6.4 EtherCAT Communications Setup

into Acontis EC-Engineer.
Set up EtherCAT communications.

▼
6.4.1 Communications Setup for the EtherCAT Master
▼
6.4.2 Distributed Clock Setup
6.4.3 PDO Map Settings
▼
6.4.4 Creation of an EtherCAT Network Configuration
File
▽
Set up the Controller.

6.5 Controller Settings
▼
10

6.5.1 EtherCAT Network Configuration Settings
6.5.2 EtherCAT Communications Check
▼
6.5.3 Motor Setup
▼
6.5.4 EtherCAT Variables Settings
▼
6.5.5 Creation of Operation Check Programs
▼
6.5.6 Project Data Transfer and Operation Check
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6.2. Preparation for the Controller Setup
Prepare the Controller settings.
Install Power PMAC IDE and Acontis EC-Engineer on the computer in advance.

6.2.1. Creation of a New Project

1

Connect the Controller with the

2

Turn on the power to the

3

Start Power PMAC IDE.

computer via Ethernet cable.
Controller.

* If the dialog for confirming
access rights appears upon
start-up, select starting of Power
PMAC IDE.

4

The Communication screen
appears. Specify the IP address
of the destination Controller and
click Connect.
* The IP address of the Controller
is set to “192.168.0.200” by
default.
* If necessary, change the
Windows IP address to
“192.168.0.X”.
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5

Power PMAC IDE starts, and is

6

From the File menu, select New

7

online to the Controller.

then Project.

Enter a project name and
location, and select OK.
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6.2.2. Initial Settings of the Controller
Configure the initial settings for the Controller.

Precautions for Correct Use
Configuring the initial settings clears all data in the Controller memory. Back up necessary
data in advance.

1

In the Terminal pane, type the
$$$*** command to reset the
Controller to factory default.

2

From the Tools menu, select
System Setup to start System
Setup.

PowerPMAC System Setup
starts.
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3

From the File menu of
PowerPMAC System Setup,
select New then Setup.

4

Specify Servo Frequency.
Select the Servo Frequency
setting from 4 kHz, 2 kHz, or
1 kHz.
* Servo Frequency is set to
1 kHz for the example in this
document.

5

Click the Accept button.

6

If you have changed the servo
frequency setting, type the save
command in the Terminal pane
of Power PMAC IDE.
When complete, the “Save
Complete” message appears in
the Terminal pane.
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7

Click Communication Setup on
the toolbar to display the Device
Properties dialog box.

8

In the Device Properties dialog
box, select No Device for IP
Address, then click the Apply
button.
This operation sets the
Controller to the offline state.

9

The Controller restarts.
The servo frequency that has
been set is reflected.

10

Wait until the startup process of
the Controller is complete. Then
click Communication Setup on
the toolbar to display the Device
Properties dialog box.
In the Device Properties dialog
box, return the IP Address to the
previous setting, then click the
Apply button.
This operation sets the
Controller to the online state.
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6.3. Installation of ESI Files
Install the ESI file for Servo Driver into Acontis EC-Engineer.

Precautions for Correct Use
Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

1

Start EC-Engineer.

EC-Engineer screen:
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2

From the File menu of
EC-Engineer, select ESI
Manager.
The ESI Manager appears.

Example of the ESI Manager

3

Confirm that Omron
R88D-KNxxx-ECT.xml is
registered in the ESI file list of
ESI Manager.
If it is not yet registered, click
Add File and register Omron
R88D-KNxxx-ECT.xml.

4
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Click Close to close the ESI
Manager page.

6.4. EtherCAT Communications Setup
Set up EtherCAT communications.

Depending on the Controller status, unexpected operations of the motion
control devices may occur when the power to the Controller is turned on,
resulting in a personal injury to the user.
Pay attention to safety when the power is turned on.

Precautions for Correct Use
Before taking the following steps, make sure that the devices are connected via an Ethernet
cable. If they are not connected, turn OFF the power to the devices, and connect the Ethernet
cable.

6.4.1. Communications Setup for the EtherCAT Master

1

Connect the Controller with
slave devices using an Ethernet
cable.
* Refer to the manuals for slave
devices to configure them.

2

Display Start Page of
EC-Engineer, and select
EtherCAT Master Unit (Class
A) from Add Master Unit.

3

Class-A Master is added to the
Project Explorer.
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4

In the Master page, specify a
communication period for Cycle
Time [us].
* You must specify the
communication period in
accordance with the servo
frequency of the Controller.
1000 us is set in this document.
Correspondence between the servo frequencies of the
Controller and communication periods is as follows:
4 kHz : 250 us
2 kHz : 500 us
1 kHz : 1000 us

5

In the Master page, enter the IP
address of the Controller in IP
Address, and click the Select
button to apply the setting.
* Default IP address
“192.168.0.200” is specified in
this example.
* Do not select Slaves
connected to local system as
it is not used.

6

Right-click on Class-A Master
in the Project Explorer, and
select Scan EtherCAT Network
from the menu.

7
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Make sure that the slave is
displayed in the Project Explorer.

6.4.2. Distributed Clock Setup

1

Setting Distributed Clocks (DC)
for Master
In the Project Explorer, select
Class-A Master to display the
Distributed Clocks tab page.

* If the Distributed Clocks tab does not appear, select View
then the Expert Mode check box.

2

Select Master Shift (EtherCAT
Master Time controlled by
Reference Clock).
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3

Setting Distributed Clock (DC)
for the Slave
In the Project Explorer, select
the target slave to display the
Distributed Clock tab page.

4

Select the Overwrite Mode
check box and specify Shift
Time.

Correspondence between the servo frequencies of the
Controller and the Shift Time values is as follows:
4 kHz : 125 us
2 kHz : 250 us
1 kHz : 500 us
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6.4.3. PDO Map Settings

PDO entries without axis settings are subjected to PDO communications as
indefinite values. For this reason, unexpected operations of the motion control
devices may occur, resulting in a personal injury to the user.
Only objects to be configured in Section 6.5.3. Motor Setup must be mapped to
PDO entries.

1

In the Project Explorer, select
the target slave to display the
PDO Mapping tab page.

2

Setting PDO mapping (Inputs)
Make sure that the 258th
transmit PDO Mapping
0x1B01 check box is selected in
the Inputs field.

3

Setting PDO mapping (Outputs)
Clear the 258th receive PDO
Mapping 0x1701 check box in
the Outputs field.
Select the 258th receive PDO
Mapping 0x1704 check box.
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6.4.4.

Creation of an EtherCAT Network Configuration File

1

Click Export ENI on the upper

2

Enter a file name, and then click

part of the EC-Engineer page.

Save to create an EtherCAT
network configuration file.

6.5. Controller Settings
6.5.1. EtherCAT Network Configuration Settings

1

From the Tools menu of Power
PMAC IDE, select System
Setup to display it, then select
Master[0] Deactivated.

2

Click Browse, and load the
EtherCAT network configuration
file created in 6.4.4 Creation of
an EtherCAT Network
Configuration File.

3

Click Download ENI file to
download the EtherCAT network
configuration to the Controller.
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6.5.2. EtherCAT Communications Check
Take the following steps to ensure that EtherCAT communications are available.

1

From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

2

In the Terminal or Watch pane,
make sure that the
ECAT[0].Enable value turns to 1.
*The OP mode is entered and
EtherCAT communications are
established.

3

After making sure that correct
communications are available,
run the ECAT[0].Enable=0
command from the Terminal
pane to stop EtherCAT
communications.

4

In the Terminal or Watch pane,
make sure that the
ECAT[0].Enable value turns to 0.
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6.5.3. Motor Setup
Configure the motor settings for the Controller.

1

From the Tools menu of Power
PMAC IDE, select System
Setup to display System Setup.

2

Click Add motor in Motors of
the tree, and enter 1 for the
motor number.
Add motor #1.

3

Select Motors – 1 – 1.Amplifier
Information.
Specify the settings as shown on
the right.
Click the Accept button to apply
the settings.
Manufacturer
Select OMRON Corporation.
Part Number
Select #x00000002.
4.ECAT Slave Settings
Enter a slave number into Slave Number.

The slave number can be confirmed in the System Setup
page.
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4

Select Motors – 1 –
3.Command/Feedback
Information.
Specify the settings as shown
on the right.
Click the Accept button to apply
the settings.
Control Type
Select Cyclic Position.
Primary Feedback
Select ECAT.

5

Select Motors - 1 - 4.Hardware
Interface.
Specify the settings as shown on
the right.
Click the Accept button to apply

Command Signal Channel

the settings.

Select #x607A(Target Position), and specify the motor
control indication value for Target Position.
Amplifier Enable Signal Output Channel
Select #x6040(Controlword), and specify Controlword
for the motor output.
Amplifier Fault Signal Input Channel
Select #x6041(Statusword), and specify Statusword for
the motor input.
Primary Feedback Channel
Select #x6064(Position actual value), and specify
Position actual value for the motor control feedback.

6.5.4. EtherCAT Variables Settings

1

In the System Setup page,
right-click on
Master[0].Deactivated to
display the pop-up menu, and
select Export EtherCAT
Variables.
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2

Enter a name for the EtherCAT
variable definition file for user
programs into the root of the
project folder.

3

The created EtherCAT variable
definition file is added to under
Global Includes of PMAC
Script Language in Solution
Explorer.

6.5.5. Creation of Operation Check Programs
Create programs to be used to check operations.
A specific language is used for the operation check programs. Refer to Power PMAC User’s
Manual and Power PMAC Software Reference Manual for details.

1

Creating the Motion program
In the Solution Explorer pane,
open Project name – PMAC
Script Language – Motion
Programs – prog1.pmc.
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2

In the programming area of the
prog1.pmc tab page, write a
program as shown on the right.
This example program rotates a
motor in the normal direction,
stops the rotation, then repeats
rotation in the reverse direction
and stops.

&1;
#1->131072X;
OPEN PROG 1
INC;
TA800;
TS300;
LINEAR;
While (1 < 2)
{
TA800;
TS300;
TM3000;
X20;
DWELL2000;
X-20;
DWELL2000;
}
CLOSE

3

Creating the PLC program
In the Solution Explorer pane,
open Project name – PMAC
Script Language – PLC
Programs – plc1.plc.
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4

In the programming area of the
plc1.plc tab page, write a
program as shown on the right.

open plc 1
while(sys.ecatMasterReady==0){};
ECAT[0].Enable=1;

This example program turns a
servo ON, starts user program 1

P1000=Sys.Time+1;
while(P1000>Sys.Time){};

for the motor, then exits periodic
execution of the PLC user

cmd"&1enable";

program.

P1000=Sys.Time+5;
while(P1000>Sys.Time){};
cmd"&1b1r";
disable plc 1;
close

5

Setting the start of the user
program
In the Solution Explorer pane,
open Project name –
Configuration –
pp_disable.txt.

6

In the programming area of the
pp_disable.txt tab page, add the
program shown on the right to
the last line.
The pp_disable.txt program is
automatically executed when the
Controller starts.
This example program runs the
PLC1 script.
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enable plc 1;

7

Setting motor control
parameters
In the Solution Explorer pane,
open Project name – PMAC
Script Language – Global
Includes – global
definitions.pmh.

8

In the programming area of the
global definitions.pmh tab page,
write the set values to be set
automatically upon power-on.
Example settings are shown on
the right.

Motor[1].FatalFeLimit=0;
Motor[1].AbortTa= -0.1;
Motor[1].AbortTs= 0;
Motor[1].MaxSpeed= 5000;
Motor[1].JogTa= -0.1;
Motor[1].JogTs= -1;
Motor[1].JogSpeed= 1000;
Motor[1].HomeVel= 1000;
Coord[1].Tm=100;
Coord[1].FeedTime=60000;
Coord[1].MaxFeedRate=5000;
Coord[1].Td=-0.1;
Coord[1].Ta=-0.1;
Coord[1].Ts=-1;
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6.5.6. Project Data Transfer and Operation Check
Transfer the created project data to the Controller.
When a project is transferred, the program starts automatically and the motor starts rotating.

When the user program and “configuration and setting” data are transferred from
Power PMAC IDE, devices or the machine may perform unexpected operations.
Therefore, before you transfer project data, ensure the destination slave is
operating safely.

Transferring project data restarts the Controller and interrupts communications
with slaves. The time that communications are interrupted depends on the
EtherCAT network configuration.
Before you transfer project data, make sure that the slave settings will not
adversely affect the devices.

The procedure provided in this section checks the operations of the motion
control devices, which may perform unexpected operations.
Take adequate safety measures before starting the checking process described
in this section. Do not start the checking process unless safety is ensured.
When performing the operation check, implement all the steps described in this
section in order to put the output into a safe state.

1

In the Terminal or Watch pane, make sure
that the ECAT[0].Enable value is 0.
If the value is 1, run the ECAT[0].Enable=0
command from the Terminal pane to stop
EtherCAT communications.
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2

Downloading a project
Right-click the project name in the Solution
Explorer pane on the upper right of the IDE
screen, and select Build and Download All
Programs to run the build and download.

3

Make sure that there are no errors in the
Output tab page.
* If the transfer fails, check details of the
error in the Output tab page.
If the error is a program error, you must
review the program.
If the error is related to EtherCAT settings,
return to System Setup and check whether
there are any incorrect settings.

4

The program starts running when it has
been downloaded successfully.
Make sure that EtherCAT communications
are in the OP state, and that the motor
rotates.
* If the motor does not rotate, check that the
ECAT[0].Enable value is 1 in the Terminal or
Watch pane.
If the value is 0, run the following command
from the Terminal pane.
enable plc 1

5

After you have confirmed an appropriate
operation, save the project to the Controller.
Run the save command from the Terminal
pane.
* The transferred project is not yet saved to
the Controller at this stage.
If you turn OFF the power to the Controller,
the transferred project will be discarded.
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7. Appendix

Saving and Loading a Project

The following describes the procedures to save a Power PMAC IDE project on the computer, and to
reuse it.

7.1. Saving a Project

1

Creating a Configuration File
Create a Configuration File to save
parameters you have changed in System
Setup to the project.
Right-click Configuration in the Solution
Explorer pane, and select Generate
Configuration File.
A Configuration File is added to
Configuration.

2

Right-click on the Configuration File, and
from the menu, select Check To
Download Config File to include it in files
to be downloaded.

3

Saving a Project
In the File menu, run Save All to save the
project on the computer.
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7.2. Loading and Downloading a Project

1

Start Power PMAC IDE, and

2

In the Terminal pane, type the

connect to the Controller.
$$$*** command to reset the
Controller settings to factory
default.

3

In the File menu, Click Open –
Project/Solution to load the
project that you saved.

4

Downloading an ENI file
From the Tools menu of Power
PMAC IDE, select System
Setup to display System Setup.

5

Click Browse, and load the ENI
configuration file that you
created in 6.4.4 Creation of an
EtherCAT Network Configuration
File.

6

Click Download ENI file to
download the EtherCAT network
configuration to the Controller.
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7

Right-click Configuration in the
Solution Explorer pane, and
select Download Config Files
to download the file to the
Controller.

8

Right-click the project name in
the Solution Explorer pane, and
select Build and Download All
Programs to run the build and
download.
When the download process is
complete, make sure that there
are no errors in the Output tab
page.

9

Stopping a program
If a program is running, execute
the following command from the
Terminal pane to stop the
program.
disable plc 1
ECAT[0].Enable=0
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10

Saving the downloaded settings
and programs
After the download process is
complete and you make sure
that there are no errors in the
Output tab page, run the save
command from the Terminal
pane.
* The save command stores the
downloaded project in the
Controller. This operation saves
the settings to be executed
automatically when the power to
the Controller is turned on.

11

Restarting after download
Run the following command
from the Terminal pane to restart
the Controller with the
downloaded project.
$$$
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8. Appendix

Troubleshooting

8.1. Factors Causing EtherCAT Communications To Be Unavailable, and
Corrective Actions
Description

Factor

Corrective Action

The link is not established.

The Ethernet cable is broken or

If the Ethernet cable is broken

the specified cable is not being

or if the specified cable was not

used.

used, replace the cable.

A connector on the Ethernet

Reconnect the connector and

cable used for EtherCAT

make sure it is mated correctly.

communications is
disconnected, the contact is
faulty, or parts are faulty.
A slave within the EtherCAT

Replace the slave.

network configuration failed.
EtherCAT communications do

ECAT[0].Enable is set to 0.

not start.

From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

The EtherCAT network

Review the settings according

configuration in the Controller

to the procedures provided in

does not agree with the

6.4 EtherCAT Communications

physical network configuration.

Setup.

The Ethernet cable is broken at

Connect the Ethernet cable

a slave in the network, or a

correctly.

connector is disconnected.
Some errors have occurred,

Check the ECAT[0].error value.

and the ECAT[0].error is set to a
value other than 0.
A synchronization error occurs

The distribution clock is not set

Review the settings according

at a slave.

correctly.

to the procedures provided in

A slave in Free-Run Mode is set

6.4.2 Distributed Clock Setup.

to the reference clock.
The servo task processing time

Review the program or servo

exceeds the set period.

frequency to adjust it, so that
the servo task processing time
does not exceed the period.
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8.2. How to Check for Errors
8.2.1. Checking the EtherCAT Status
You can check the EtherCAT status from System Setup of Power PMAC IDE and Diagnosis Mode
of Acontis EC-Engineer.
 System Setup of Power PMAC IDE
You can check the status of the EtherCAT master and slaves in the System Setup page of Power
PMAC IDE.

 Diagnosis Mode of Acontis EC-Engineer
You can check the status of the slaves in the Diagnosis Mode page of Acontis EC-Engineer.
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Select Network then Network Mismatch Analyzer from the menu to verify the network configuration.

8.2.2. Checking the Controller Status
In the Status page of Power PMAC IDE, you can check the status of the motor, coordinate system,
and system.
To display the Status page, click Status on the toolbar.

 Global Status
You can check system errors such as the WDT error.
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 Motor Status
You can check deviation errors, limit errors, and other states of the motor.

 Coordinate Status
You can check deviation errors, limit errors and other states of the coordinate system.
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9. Appendix

ECAT[i] Structure Elements

The Controller uses motion controller technology developed by Delta Tau Data Systems, Inc.,
(hereafter referred to as DT) in the U.S., however, the ECAT[i] structure elements differ from those of
DT controllers. The following table shows the major changes that have been made from DT
controllers.
Element name

Description

Change

ECAT[i].Enable

Enabling the EtherCAT

0: Disable, 1: Enable (2 and 3 are not

network

supported.)

Elements of low priority

Not supported

ECAT[i].LPIO[k]

I/O module
ECAT[i].Slave[j]

Slave elements

Not supported

ECAT[i].Error

Error code of enabling

$ 9811000C: Invalid network

EtherCAT network

configuration
$ 9811002E: Disconnected network
connection

ECAT[i].LinkUp

Status data structure

ECAT[i].LPDomainOutputState

elements

ECAT[i].LPDomainState
ECAT[i].LPRxTime
ECAT[i].LPTxTime
ECAT[i].MasterStat
ECAT[i].RTDomainOutputState
ECAT[i].RTDomainState
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Not supported
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